IU MASTER STUDENT

THESIS FORMAT PRE-CHECK WORKSHOP

Presented by

Debra Barker
Recorder

IUPUI Graduate Office

The University Graduate School
Indiana University
# TABLE OF CONTENTS

Campus and Graduate School Resources .................................................................................. 3
Graduate Student Writing Group ................................................................................................. 4
IU IUPUI Fall 2013 Deadlines .................................................................................................... 5
IU IUPUI Spring 2014 Deadlines ................................................................................................ 6
IU IUPUI Summer 2014 Deadlines ............................................................................................ 7
How Long Does It Take, Choosing Topic to Graduation ............................................................. 8
Common Format Mistakes .......................................................................................................... 9
IU Master Format Checklist ........................................................................................................ 11
Setting Margins and the Header/Footer ..................................................................................... 12
Table of Contents and the Leader (dots) .................................................................................. 13
How to Insert Landscape Page Numbers .................................................................................. 14
Appendices ................................................................................................................................ 18
  Defense Announcement ............................................................................................................. 19
  Master Title page ....................................................................................................................... 20
  Master Acceptance page .......................................................................................................... 21
  Abstract .................................................................................................................................. 22
  Table of Contents .................................................................................................................... 23
  Curriculum Vitae ...................................................................................................................... 24
IUPUI ScholarWorks .................................................................................................................... 25
Document Binding ...................................................................................................................... 27
Thesis Deposit Checklist ............................................................................................................ 28
Format Review and Scheduling .................................................................................................. 29
IUPUI Home Page
http://www.iupui.edu/

IUPUI Graduate Office – New website!
http://graduate.iupui.edu/

Format Guide – New website!
http://graduate.iupui.edu/theses-dissertations/index.shtml

IUPUI University Writing Center
http://liberalarts.iupui.edu/uwc/

University Information Technology Services
http://uits.iu.edu/

IT Training
http://uits.iu.edu/page/amec

IUware and IUanyWare
http://iuware.iu.edu/

Commencement at IUPUI – Occurs in May
http://alumni.iupui.edu/

Official Transcripts
http://registrar.iupui.edu/transcript/

Diplomas
Diplomas are not presented at the May commencement ceremonies. When diplomas are available for distribution, students will receive a notification via the email listed in OneStart with a request to verify the student address. Upon reply the diploma will be mailed. The approximate delivery schedule for diplomas is as follows:
  - Spring graduates: mid August
  - Summer graduates: late November
  - Fall graduates: mid May
The Graduate Student Writing Group provides graduate and professional students weekly support and accountability with writing projects such as thesis and dissertations, grants or publications. The format allows participants to dedicate time to write, review, and discuss projects, receive feedback and participate in skill building activities offered by the National Center for Faculty Development and the IUPUI Writing Center.

Register @

https://www.surveymonkey.com/s/GraduateandProfessionalWritingGroup
IU IUPUI FALL 2013 DEADLINES

Master Students

This is a suggested schedule to be a successful December 2013 graduate.

<table>
<thead>
<tr>
<th>Date</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>November 11, 2013</td>
<td>Last day for Master student to defend to graduate December 2013.</td>
</tr>
<tr>
<td>November 13, 2013</td>
<td>Last day for Format Review of Thesis (post defense) by Debra Barker of the IUPUI Grad Office.</td>
</tr>
<tr>
<td>November 21, 2013</td>
<td>Last day to upload format approved documents via ScholarWorks to the IUPUI library.</td>
</tr>
<tr>
<td></td>
<td>For information on IUPUI ScholarWorks logon to: <a href="https://scholarworks.iupui.edu/">https://scholarworks.iupui.edu/</a>.</td>
</tr>
<tr>
<td></td>
<td>Before uploading a document, students are required to have at least one format review with Debra Barker of the IUPUI Graduate Office. To schedule a format review, contact Debra Barker at <a href="mailto:dsulliv2@iupui.edu">dsulliv2@iupui.edu</a>.</td>
</tr>
<tr>
<td>December 18, 2013</td>
<td>Last day to submit Fall 2013 grades.</td>
</tr>
<tr>
<td>December 6, 2013</td>
<td><strong>Deadline to deposit bound thesis.</strong></td>
</tr>
<tr>
<td>December 16, 2013</td>
<td>Official Graduation Date.</td>
</tr>
</tbody>
</table>
## IU IUPUI SPRING 2014 DEADLINES

**Master Students**

This is a suggested schedule to be a successful May 2014 graduate.

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 9, 2014</td>
<td>Last day for Master student to defend to graduate May 2014.</td>
</tr>
<tr>
<td>April 15, 2014</td>
<td>Last day for Format Review of Thesis <em>(post defense)</em> by Debra Barker of the IUPUI Grad Office.</td>
</tr>
<tr>
<td>April 21, 2014</td>
<td>Last day to upload format approved documents via ScholarWorks to the IUPUI library.</td>
</tr>
<tr>
<td></td>
<td>For information on IUPUI ScholarWorks logon to: <a href="https://scholarworks.iupui.edu/">https://scholarworks.iupui.edu/</a>.</td>
</tr>
<tr>
<td></td>
<td>Before uploading a document, students are required to have at least one format review with Debra Barker of the IUPUI Graduate Office.</td>
</tr>
<tr>
<td></td>
<td>To schedule a format review, contact Debra Barker at <a href="mailto:dsulliv2@iupui.edu">dsulliv2@iupui.edu</a>.</td>
</tr>
<tr>
<td>May 13, 2014</td>
<td>Last day to submit Spring 2014 grades.</td>
</tr>
<tr>
<td><strong>May 6, 2014</strong></td>
<td><strong>Deadline to deposit bound thesis.</strong></td>
</tr>
<tr>
<td>May 11, 2014</td>
<td>Official Graduation Date.</td>
</tr>
</tbody>
</table>
# IU IUPUI SUMMER 2014 DEADLINES

## Master Students

This is a suggested schedule to be a successful Summer 2014 graduate.

<table>
<thead>
<tr>
<th>Date</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>July 3, 2014</td>
<td>Last day for Master student to defend to graduate August 2014.</td>
</tr>
<tr>
<td>July 10, 2014</td>
<td>Last day for Format Review of Thesis (post defense) by Debra Barker of the IUPUI Grad Office.</td>
</tr>
<tr>
<td>July 17, 2014</td>
<td>Last day to upload format approved documents via ScholarWorks to the IUPUI library. For information on IUPUI ScholarWorks logon to: <a href="https://scholarworks.iupui.edu/">https://scholarworks.iupui.edu/</a>. Before uploading a document, students are required to have at least one format review with Debra Barker of the IUPUI Graduate Office. To schedule a format review, contact Debra Barker at <a href="mailto:dsulliv2@iupui.edu">dsulliv2@iupui.edu</a>.</td>
</tr>
<tr>
<td>August 13, 2014</td>
<td>Last day to submit Summer 2014 grades.</td>
</tr>
<tr>
<td><strong>August 7, 2014</strong></td>
<td><strong>Deadline to deposit bound thesis.</strong></td>
</tr>
<tr>
<td>August 11, 2014</td>
<td>Official Graduation Date.</td>
</tr>
</tbody>
</table>
HOW LONG DOES IT TAKE, CHOOSING TOPIC TO GRADUATION

Ponder topic
Narrow in on topic
Identify committee
Streamline topic
Re-confirm committee
Conduct research
Finish research
Continue write up
Meet with committee (several times)
Finish document for defense
Schedule defense  (could take six months to reach the scheduling of your defense)
Pass defense
Finish committee revisions
Format review
Finish touching up approved format
Submit electronically to IUPUI Library ScholarWorks
Electronic submission approved or required resubmission
Required submission of bound document? Binding can take 1-3 weeks
Deposit complete by Graduate School deadline (Format review to deposit could take six weeks)

Realistically? Start to Finish Equals no less than 12 months.
COMMON FORMAT MISTAKES

This is a summary of common mistakes

Font and Font Size
Font and font size will be consistent throughout materials, including preliminary material, document, headings, and all page numbers.

Currently approved fonts are:
- Arial
- Bookman
- Calibri
- Cambria
- Lucida Bright
- Times New Roman

Footnotes
Footnotes, if used, are placed at the bottom of the page and no smaller than 10pt font.

Headings
Your program or committee may have a specific format. Overall, be consistent, your document should appear as professional as you intend.

Hyphens, dashes, and minus signs
These are all different. The identified style guides have a section dedicated to this topic.

Hyperlinks
These will be the same format style as your text.

Labeling, Consistency in text, chart, figure, table, etc.
Table or table;
Figure or figure, Fig. or fig.;
et al. or et al.

Order of front and ending material
Title page (no page number)
Acceptance page with original signatures (page ii)
Copyright page (if copyrighted)
Dedication (optional)
Acknowledgements (recommended)
Preface (optional)
Abstract (optional – consult your department)
Table of Contents
List of Tables, List of Figures, List of Abbreviations (recommended if appropriate)

The following matter should appear, in this order, at the end of the dissertation or thesis:

Appendix (appendices) (recommended if appropriate)
References (if appropriate; these may be single spaced)
Curriculum Vitae (mandatory) placed at the end of the dissertation or thesis (no page number)
Page numbers
Front matter is Roman numerals. Document is Arabic numerals.
Font and size match the font and size of the document.
Location is centered as a header/footer at half inch (0.5”) from page edge.

Punctuation
Consistency of in text lists.
Consistency of in text references, whether in or out of parentheses.

Quotes, Indention of Long
Single spaced, indented on left side AND right side by 0.5 inch.

References
There are several programs to assist with reference formatting. The identified Style Guides also offer formats.
If you elect to manually format your references – be consistent.
Do not split a reference between two pages. Move the entire entry to the next page.
URLs, use only the color black. Identify date accessed or retrieved.

Spell Check
Do not assume your word processing program is 100% correct.
Recommended dictionaries,
  - Webster’s New International Dictionary
  - Webster’s Ninth New Collegiate Dictionary

Style Guides
American Psychological Association (especially for works in the social sciences);
The Chicago Manual of Style;
Turabian, Kate L., A Manual for Writers;
Modern Language Association; and
LaTeX (especially for works in engineering and science).

Symbols
Verify the character code. Choices and recently used codes will vary by computer, computer program, and user.

Widows/Orphans
This is a single line of text at the bottom of the page or at the top of the page.
IU MASTER FORMAT CHECKLIST

Paper size. Letter, 8.5x11”.

Margins. Left 1.5”, Right 1.0”, Top 1.0”, Bottom, 1.0”.

Page numbers.
   Header or footer 0.5 inch, and centered. Font/size match Document.
   Front material, Roman and lower case.
   Document through references, Arabic.
   Curriculum Vitae, no number.

Spacing after periods / Spacing after colons. Use one space OR two spaces. Be consistent.

Footnotes, single spaced, same font as document, size no smaller than 10pt.

Long quotes, single spaced, and indent both sides 0.5 inch.

Landscaped pages, layout, margins, and page number correct direction.

Title page, format matches university requirement. Your name matches OneStart transcript.

Acceptance page, committee's names include Middle Initial and degrees.

Acknowledgements. Thank your program, committee, funding sources, entities that provided resources.

Abstract. Unsigned layout.
   Your name matches the title page.
   Only committee chair is listed, no signature.
   Word count limit, 350.

Table of Contents.
   Titles and page numbers match document.
   Curriculum Vitae will not have a page number

List of Tables, List of Figures.
   Titles and page numbers match document.

List of Abbreviations.
   Columns line up.

Document.
   Headings formatted consistently.
   Tables labeled consistently.
   Figures labeled consistently.

References formatted consistently.

Curriculum Vitae.
   Your name matches the title page.
   This degree is earned at Indiana University.
   The curriculum vitae will not have page numbers.

Spring 2014
SETTING MARGINS AND THE HEADER/FOOTER

Highlight document.

At the top of your screen is Page Layout.

Choose Page Setup.

Select the Arrow in the lower Right corner of this box.

The front tab is Margins.
    Set Top as 1.0; Set Left as 1.5; Set Bottom as 1.0; Set Right as 1.0.

The other items will remain their default.
    Gutter 0;
    Gutter position Left;
    Orientation Portrait;
    Pages, Multiple pages Normal;
    Preview, Apply to Whole Document.

The center tab is Paper.
    Select Letter. The default margins are Width 8.5” and Length 11”.

The right tab is Layout. This is to set the Header and Footer positions.
    Header will be 0.5”
    Footer will be 0.5”
TABLE OF CONTENTS AND THE LEADER (DOTS)

This function may also be applied to the list of tables, list of figures, and list of abbreviations.

The dots are called Leaders, and often referred as Leader Dots.

The dots can be created by using the table of contents template. However, this will import Word’s choice of font, size and style, which may not match your document layout. If using Word’s template you will modify the setup to choose the correct font and size.

Verify the margins are Left 1.5” and Right 1.0”.

Verify the table of contents is Left Aligned. If not, At the top of your screen, on the Home tab, is the box Paragraph. Select Left Aligned.

You are ready to proceed.

Turn on Show/Hide. This reveals the spaces surrounding your titles and extraneous spaces.

Remove the dots.

Highlight the table of contents.

At the top of your screen, on the Home tab, is the box Paragraph. Select this.

The front tab is labeled Indents and Spacing. At the bottom of this screen is a box labeled Tabs. Select Tabs.

On the Tab screen, select the box labeled Clear All.

Select the box labeled OK.

You have returned to the table of contents and the material is still highlighted. Keep this material highlighted.

Go back to Paragraph, Indents and Spacing, and Tabs.

The Tab stop position box. Enter the number 6. This represents six inches from the left margin.

Move to the section labeled Alignment. Select Right.

Move to the section labeled Leader. Select 2……

Select the box labeled Set.

Select the box labeled OK.

You have returned to the table of contents, the material may be highlighted. Un-highlight.
At this moment your material may have moved to the right edge of the paper and there are dots to the left of that material.

Remove the dots before the material. The material will now be on the left margin.

Move your cursor to the end of your title. Press the Tab key one time. The dots should stream to the right margin. Place the page number immediately beside the last dot. The dots will adjust automatically for the number and spacing.

The material that was tabbed/offset to indicate subheadings. Place the cursor to the left of that material.

At the top of the screen; on the Home tab; return to the box labeled Paragraph. Select the function Increase Indent. Select this function one time for one indentation. The indent is defaulted to 0.5”. If the document used less than 0.5” for the tab, you may change the indent stop to match the original set up.
HOW TO INSERT LANDSCAPE PAGE NUMBERS

How to put page numbers in the corner of a page with landscape orientation

1. Make a text box
   a. Insert ➔ Shapes ➔ Text Box

2. Type a number in the text box
   a. Make sure you use the same font and size as the rest of your page numbers
   b. You can manually enter the page number OR
   c. You can also go to the page header (from the #d pages) and copy the page number out of the header and paste the page number into the text box. (If you copied the page number correctly, the page number when highlighted should have a special gray background.) By obtaining the page number this way, the page number character is linked to other page numbers in the document. You can update the page number by highlight the page number, right clicking on the number, and selecting the “Update field” option. Note this option is not helpful if the horizontally positioned page is not in the correct page order in the thesis. But this function can be helpful if the page is at the end of the thesis.

3. Turn the font
   a. Highlight the page number in the text box

   b. Select the Format Tab

   c. On the far left of the bar, click on text direction to turn the font

Congratulations, you’ve turned the font in the text box! But having a turned text box doesn’t help us unless the text box is in the right position on the page.
The following tricks can help to put the text box in exact the right location in the corner of the page. Trial and error is still needed through as this is not an exact science.

Note: different fonts and different text sizing result in a lack of a one-size-fits-all option for this page numbering. Minor changes in formatting are thus needed specific to each font size and type.

Here's how to make a ruler to help with the text box positioning:

a. Draw 2 lines in a L shape such that the lines meet over the page number in the corner of the page.

b. Hold down the CTRL button and select both lines.

c. Right click on the lines and select the group option.

d. Now you can select the object and under the Page Layout tab you can select Rotate to rotate the lines 90 degrees.

e. Now position the “L” in the bottom right hand corner of the page that is horizontally positioned. (This “L” may help you position the text box in the
corner, but note that this “L” may not help you perfectly.) Make sure that the “L” is selected to have the Order to be On Top

f. Now, select the text box and select Order ➔ send to back

g. Add an extra blank line to the right/above the page number

h. Position the text box in the bottom right hand corner of the page

i. Make modification s to the text box (size of text box, position of text box) and modifications to the text (size, shape, extra spaces, extra lines etc, size of the extra spaces or lines) such that:
   1. The text box edge touches the edges of the corner
   2. The page number is positioned where you think the page number should be (based upon the position of the intersecting lines in the “L”)

j. Now, print off a Portrait page with a page number and your recently page numbered landscape page

k. Alight the pages on top of one another and hold the pages up to the light to see how the page numbers are positioned relative to one another.

l. Make adjustments to correct the page number position using the techniques discussed in part “i”

m. Memorize how the text box is positioned in the corner (look at the reference squares of the selected text box

n. Select the text box, remove the line around the box

o. Remove the “L”

p. If you have other landscape pages that need a page number, simply copy and paste the modified text box to those pages and position the text box correctly in the corner using the position cues you remembered (part “m”).

NOTE: the text box is part of the page, if you paste large diagrams in the page, the text box may move- correct positioning like in part “p”
APPENDICES

Defense Announcement
Master Title page
Master Acceptance page
Abstract, unsigned
Table of Contents
Curriculum Vitae
REQUIREMENTS, As Shown
One (1) inch margins all around
One (1) font. One (1) size, 11 or 12 pt only
Single space only

Announcing the
Final Examination of
Student Name as appears in OneStart on transcript
for the
Degree of Master of Arts / Science in [department/school name]
Day, Date, Time [identify start and end time]
Room, Building

Dissertation: Format Precheck Workshop

The summary, no less than 150 words, is informative and contains a brief statement of the principal results and conclusions. Unlike the abstract, which is for specialists in the field, an attempt should be made in the summary, whenever possible, to communicate the findings in language and style that can be understood by the University community at large.

Outline of Studies
[This is your current studies]  Educational Career
Major: Field  [This is prior degrees]
Minor(s): Field and Department  [do not include major or minor]

Committee in Charge
Committee Chair Name and Degrees, Chairman, Phone Number, Department
Alphabetically list, in column format, the remaining committee members,
Identify Name and Degrees Only
Note: All Committee member names. Identify first name, middle initial if available, last name.

Approved:  Signature
Chairman’s Name, Degrees Typed

(Any member of the Graduate Faculty may attend. As a courtesy, please notify the Committee Chairman in advance.)

Notes: This clause and layout is required, utilize same font and size as this page.
This must be turned in no less than 30 days prior to your defense to the IU Graduate School through the Graduate Office at IUPUI.

(Medical Science students need to submit announcement to IU School of Medicine, MS 207 for approval before it is then forwarded to IU Graduate School. Allow enough time to meet the 30 day requirement for the IU Graduate School)
TITLE CENTERED, ALL IN CAPITAL LETTERS, DOUBLE SPACED:

THE IMPORTANCE OF KEY WORDS IN THE SUCCESSFUL INDEX

(Font size should be no smaller than 12, and no larger than 16)

Author’s Name as it appears on your OneStart transcript

(Author’s name same font and size as document text)

Submitted to the faculty of the University Graduate School
in partial fulfillment of the requirements
for the degree
Master of [Arts or Science]
in the Department [or School] of [Department/School Name],
Indiana University

Month Year

(This clause and date is same font and size as document text)

(The date should reflect the actual date of the degree – which is the month that deposit requirements are completed for the IU Graduate School through the Graduate Office at IUPUI.)
This page is not titled

This clause is centered.

Accepted by the Graduate Faculty, Indiana University, in partial fulfillment of the requirements for the degree of Master of [Arts/Science].

This phrase is Left aligned.

Master’s Thesis Committee

Committee Chair’s signature
name typed [include degree], Chair

Second reader’s signature
name typed [include degree]

Third reader’s signature
name typed [include degree]

Fourth reader’s signature
name typed [include degree]

The layout of this page is the required format as established by Indiana University.
Do not type “Abstract” at the top of the page.

Student’s Name [as it appears on the Title page]

Thesis Title

[Title must be Title Case and underlined or all CAPS]

The abstract is double-spaced and limited to 350 words. The paragraph(s) layout, indentation and line spacing, will match your document.

Committee Chair’s Name as appears on Acceptance Page

[This is Right Aligned]
TABLE OF CONTENTS

[a sample format]

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of Tables</td>
<td>iv</td>
</tr>
<tr>
<td>List of Figures</td>
<td>v</td>
</tr>
<tr>
<td>List of Abbreviations</td>
<td>vi</td>
</tr>
<tr>
<td>Chapter One</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Conversation</td>
<td>2</td>
</tr>
<tr>
<td>Chapter Two</td>
<td></td>
</tr>
<tr>
<td>Methods</td>
<td>10</td>
</tr>
<tr>
<td>Conclusion</td>
<td>95</td>
</tr>
<tr>
<td>Appendices</td>
<td></td>
</tr>
<tr>
<td>Appendix A</td>
<td>100</td>
</tr>
<tr>
<td>Appendix B</td>
<td>101</td>
</tr>
<tr>
<td>References</td>
<td>110</td>
</tr>
<tr>
<td>Curriculum Vitae [CV - No leader dots, no page number]</td>
<td></td>
</tr>
</tbody>
</table>
CURRICULUM VITAE
(there is no page limit)

Your Name [as it appears on the Title Page]
[Your name may be centered, or flush left]

Do not include personal information.

Education
You may list this degree.

Note: Your degree is an Indiana University degree, earned at Indiana University Purdue University Indianapolis (or IUPUI)

(The following can be listed in any order)

Honors, Awards, Fellowships

Research and Training Experience

Professional Experience

Conferences Attended (This may include Presentations, Poster Sessions)

Publications (May include those that are submitted or in progress)

NOTE: This is just a listing of some of the things that appear on a curriculum vitae. There is no specific format (except for font, type size, and margins) however you may want to consult your advisor.

The Curriculum Vitae does not have page numbers.
Congratulations on nearing the completion of your thesis or dissertation! Your school or department is participating in digital submission of theses and dissertations into IUPUI ScholarWorks. NOTE: Your school or department may still require submission of a traditionally bound copy of your thesis. Ask Debra Barker if you are unsure.

How does submitting your thesis to IUPUI ScholarWorks benefit you?

- You save money because there is at least one less bound copy you need to produce.
- IUPUI ScholarWorks is freely accessible to anyone on the web and crawled by Google and other search engines. This means potential employers and other scholars can easily locate your research, possibly increasing citation of your work.
- IUPUI ScholarWorks is a digital archive, meaning University Library is dedicated to ensuring that your electronic thesis or dissertation is maintained under current technological best practices.
- IUPUI ScholarWorks creates a unique and persistent Uniform Resource Identifier (URI) for every submitted item. This means that your thesis or dissertation will have a constant, unchanging link that you, and others citing your work, can include in bibliographies. No more dead links.
- IUPUI ScholarWorks tracks the number of times your ETD is downloaded, giving you insight into the impact your work is making.
- IUPUI ScholarWorks is full-text searchable.
- If you so desire your thesis or dissertation can still be submitted to various third party indexers including ProQuest.
- An IUCAT and OCLC WorldCat record will continue to be created by University Library for your thesis or dissertation, meaning your work will be included in at least two library catalogs.
- You’re in good company. Students at universities across the world including: Texas A & M University, Drexel University, MIT, Oregon State University, University of North Carolina at Chapel Hill, and Yale University among others have begun submitting and archiving their thesis electronically.

What to do next? You may have noticed that an automated email from dspace regarding IUPUI ScholarWorks entitled “Change Password Request” just popped up in your email. Please follow the instructions set forth in that email. Information regarding how to submit is provided in the 2 guides linked below.

- Information I want people to know about my thesis or dissertation
  https://scholarworks.iupui.edu/themes/IUPUIScholarWorks/pdf/Info.pdf

- Submitting a thesis or dissertation to IUPUIScholarWorks
  https://scholarworks.iupui.edu/themes/IUPUIScholarWorks/pdf/Submit.pdf
Help contacts:

- Anna Proctor aproctor@iupui.edu of University Library if you have question specifically regarding the electronic submission of your document to IUPUIScholarWorks.

- Please contact Anna Proctor if you wish to submit any datasets (manipulated or raw data) associated with your thesis or dissertation.

- Debra Barker dsulliv2@iupui.edu of the Graduate Office if you have questions regarding the Graduate School established requirements for all thesis and dissertation preparation.

Thanks for your participation in this exciting venture in digital scholarship,

Anna Proctor and Debra Barker

Anna Proctor  
Digitization Coordinator  
IUPUI University Library  
UL1115  
755 W. Michigan  
Indianapolis, IN 46202  
office: (317) 278-8492  
aproctor@iupui.edu
National Library Bindery Company of Indiana, Inc.

55 South State Avenue #100
Indianapolis, IN 46201-3876

(317) 636-5606

www.nlbco.com

Open: Monday–Friday, 8:00am–5:00pm

Normal process is 21 days
Rush process is 7 days
Electronic submission is 28 days

Delivery service. Courier delivery within Indianapolis.

Payment accepted: Cash, Money Order or PayPal Email Invoice Only.

All orders must be paid in full at time of pick up or prior to shipping.

Submit one (1) bound document to the IUPUI Graduate Office. This may be printed on copier-type paper. The bound document(s) MUST contain a photocopy of the signed acceptance page. After your degree is awarded this bound volume will become your program’s copy.

Note: Check with your program for their bound document requirement.
THESIS DEPOSIT CHECKLIST

1. TURN IN PRIOR or AT TIME OF FORMAT REVIEW
   Copy of Signature/Acceptance Page.

2. FORMAT REVIEW PASSED YOU WILL MOVE FORWARD IN THIS ORDER
   Submit electronically the format approved document to IUPUI Library “ScholarWorks”.
   The link for this submission will be sent by email from Anna Proctor or Kristi Palmer.

3. BINDERY
   Submit one (1) bound document to the IUPUI Graduate Office. This may be printed on copier-type paper. The bound document(s) MUST contain a photocopy of the signed acceptance page.
   After your degree is awarded this bound volume will become your program’s copy.
   Note: Check with your program for their bound document requirement.

   Bindery contact information:
   National Library Bindery Co.
   55 South State Avenue #100
   Indianapolis, IN 46201-3876
   (317) 636-5606 www.nlbco.com
   Open: Monday – Friday, 8 am to 5 pm.
   Normal process is 21 days. Rush process is 7 days. Electronic submission is 28 days.
   Payment procedure: Consult with the Bindery.

~~~

DEGREE AWARD
Deposit completed by the 10th day of the month, you will be eligible to graduate that month.
The degree will be awarded as the last day of the month.

DEGREE POSTING
Degrees are posted to the student record the middle of the following month.
The degree date will be labeled as the last day of the month deposit was complete.

DIPLOMA ARRIVAL
Fall diplomas arrive May. Spring diplomas arrive August. Summer diplomas arrive December.
You will be contacted of the arrival by the email listed in OneStart.

DEGREE VERIFICATION FOR ANOTHER DEGREE PROGRESSION, JOB, POST-DOC, VISA
Degree verification is completed by Debra Barker.
Send an email to Debra containing the name, credentials, company they represent, address, and their email. The letter will be sent to the identified person(s).

TRANSCRIPTS
Immediately following the posting of the degree, the degree will appear on the transcript.
Immediately following the posting of the degree, official transcripts can be ordered.

All questions and concerns regarding degree completion should be directed to
   Debra Barker, dsulliv2@iupui.edu
FORMAT REVIEW AND SCHEDULING

Format Reviews are conducted by electronic submission Only.

Contact:

Debra Barker
Recorder
The University Graduate School
IUPUI Graduate Office

e-mail Debra Barker: dsulliv2@iupui.edu

• Schedule early – most students require two (2) review sessions.
• Format review will not occur the same day as defense.
• Reviews (New for Fall 2013) First review will be electronic. You must contact Debra Barker, via email, early for details. Rush/Late requests will honored only as time permits.
• Electronic format review will not occur the same day as email received.
• All committee revisions must be in place prior to submission for review.
• Copy of signed acceptance page must be on file.

Plan early – there are no provisions for student and/or committee lateness.

Thank you for your attendance.